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Introduction 
Amir Imanzadeh and Frank J. Rybicki 

 
The term “3D printing” refers to fabrication of a tangible object from a digital file by a 3D 
printer. Materials are deposited layer-by-layer and then fused to form the final object. Many 
different materials can be used to fabricate the model. Additive Manufacturing (AM), Rapid 
Prototyping (RP), and Additive Fabrication (AF) are synonyms for 3D printing. According to 
the most recent classification by American Society of Testing and Materials (ASTM), there 
are seven major types of 3D printing technology. Although these technologies share 
similarities, they differ in speed, cost, and resolution of the product.  
 
Digital Imaging and Communications in Medicine (DICOM) image files cannot be used 
directly for 3D printing; further steps are necessary to make them readable by 3D printers. 
The purpose of this hands-on course is to convert a set of DICOM files into a 3D printed 
model through a series of simple steps. Some of the initial post-processing steps may be 
familiar to the radiologist, as they share common features with 3D visualization tools that are 
used for image post-processing tasks such as 3D volume rendering. 
 
Most 3D printed models are derived from DICOM images generated from CT scans. Images 
should be reconstructed from isotropic voxels with slice thickness less than or equal to 1.25 
mm. For 3D printing, image post-processing has both similarities to and substantial 
differences from methods used by radiologists for 3D visualization.  
 

 As in 3D visualization, specific software packages enable segmentation of 
DICOM images using semi-automated and manual segmentation algorithms, 
allowing the user to demarcate desired parts. The most commonly used tools are 
thresholding, region growing, and manual sculpting.  

 
 The segmented data are then exported in a file format that can be recognized by 

3D printers. In essence, this process is conversion of 2D images to 3D triangular 
facets that compose a mesh surface. To date, the most widely used format is 
Standard Tessellation Language (denoted by the file extension “STL”).  

 
 In most cases, the STL output is not optimized for printing and further refinement 

is required. This refining step may be unfamiliar even to radiologists versed in 3D 
visualization; Computer Aided Design (CAD) software is used to perform steps 
such as “wrapping” and “smoothing” to make the model more homogeneous.  
 

 A key part of 3D printing is choosing the appropriate hardware technology and 
material. There are several considerations in choosing which technology to use, 
such as availability, cost, speed, biocompatibility, and most importantly 
anticipated usage of the product (e.g., a model for surgical planning versus a 
custom made implant).  

 
Our ultimate goal is to educate participants about the capabilities of 3D printing and, through 
this hands-on-exercise, provide an initial working knowledge of how it is performed.   
This session focuses on image post-processing of DICOM image files generated from a CT 
scan for 3D printing. Participants will learn to segment simple to moderately complicated 
structures and prepare them for 3D printing. Using this handout as a guide, we will teach 
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participants to use three software packages, Mimics and 3-matic (Materialise) and Objet 
Studio (Stratasys). The following descriptions are provided by the vendors*.  

 
Mimics is an image-processing package that interfaces between 2D image data (e.g., CT, 
MRI) and 3D engineering applications. Mimics is widely used in academics, hospitals, and 
industry for 3D printing as well as for anatomical measurements, 3D analysis, Finite Element 
Analysis, patient-specific implant or device design, and surgical planning or simulation. 
Within Mimics, users can segment any region of interest that can be seen in the medical data 
and accurately create a 3D model of patient anatomy.  

 
3-matic is a Computer Aided Design (CAD) package dedicated for use with anatomical data. 
It can perform common CAD operations directly on triangulated STL files. It can also be used 
to optimize the triangle mesh so the anatomical models can be used in a finite element 
package. 
 
Objet Studio makes building high-quality, highly detailed and accurate models a fast, 
efficient operation. Objet Studio supports STL and SLC files from any 3D CAD application. 
The software offers simple “click & build” preparation and print tray editing. It provides easy, 
accurate job estimation and full job control, including queue management. The software also 
features powerful wizards that facilitate and speed system maintenance.  
 
  

                                                   
* Please note that the course director and staff do not endorse or receive funding or royalties 
from 3D printing products. Similarly, the RSNA does not endorse specific commercial 
products.  However, the company trade names are inherently part of this course because using 
them is the only way to effectively communicate the educational message. 
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We will segment the abdominal aorta and prepare an STL file that can be printed. Because 
time in this Hands-On Session is limited, the RSNA computers have the CT DICOM images 
pre-loaded, and the software has already been launched. In practice, these simple initial steps 
require additional understanding of the software (described in APPENDIX I). 

Before we begin Task A, we will introduce the Mimics software environment, specifically the 
menus, toolbars, windows, and shortcuts. 
 

 
 
 

 
  

Shortcut Action 
Scroll wheel (center mouse) 
OR Shift+right click+drag 

Pan: Move the mouse while keeping the center click 
pressed 

Ctrl+right click+drag Zoom: Move the mouse vertically while keeping the 
buttons pressed to zoom in and out 

ArrowUp/Scroll wheel up Go to next slice 
ArrowDown/Scroll wheel 

down 
Go to previous slice 

PageUp Skip 10 slices upward 
PageDown Skip 10 slices downward 
CTRL + L Make slice indicators visible/invisible 

SPACE Zoom window with cursor to full screen 
Backspace Switch between two window states 

Right click + drag on 
images 

Adjusts contrast window in images 
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Task A. Creating a Mask of (Segmenting) the Aorta 
 
WHAT YOU ARE DOING: Segmenting the aorta. The term “segmentation” describes the task of 
identifying specific voxels in a region of interest such as the aorta. You will isolate the contrast-
enhanced lumen of the aorta from the rest of the data in the DICOM images.  
WHY YOU ARE DOING IT: To identify the voxels that will eventually be represented in the 3D printed 
model. 
HOW TO DO IT: The two segmentation tools that will be used are “Thresholding” and “Region Growing”. 
Both may be familiar from experience with standard 3D visualization. 1) Thresholding isolates voxels 
with attenuation within a specified Hounsfield Unit (HU) range. 2) In region growing, the user manually 
identifies a seed point and the software selects voxels within the specified HU range that are physically 
connected to that seed point. 
 
Each of these steps creates a “mask” or intermediate model that could be printed after further 
manipulations. A list of the masks you have created appears in the first pane of the Project 
Management Toolbar (this is located on the top right of your screen). 
 
1. From the Segmentation Menu in the top Toolbar, choose Thresholding . This opens a 
window in which you can specify a HU range. This step creates a mask containing only the 
pixels that fall within the specified HU range. 

 

 
 

Set the HU range from 351 to 1399 to eliminate those tissues that fall outside 351-1399 HU. 
Bone and the contrast material in the aorta will appear green in the images. 

 

2. From the Segmentation Menu, choose Region Growing . This tool creates a new mask 
(yellow) containing only those voxels within the source (green) mask that are connected to the 
seed point that you identified. 
 
3. Left-click on a point within the aorta (from any of the three planes) to specify a seed point. 
This will highlight the aorta and its major branches in yellow, while the rest of the highlighted 
tissue from the previous mask (e.g. bone) remains in green. Close the Region Growing tool.  
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The yellow arrow in the screen shot above indicates where you should left click (within the 
aorta) to perform the region growing (step 3 above). 

 
Hint: Make sure the Multiple Layer option box is selected. This will perform the operation throughout the entire 
image stack. 
 
4. Next, we will “Calculate” a 3D rendering of the aorta from the yellow mask. This 
intermediate step allows you to visualize the result of the two segmentation steps combined. 
From the Segmentation Menu, choose Calculate 3D . Ensure that the yellow mask is 
highlighted and the Quality is set to Optimal and hit the Calculate button to create a “3D 
object”. 

 

 
 

A list of the 3D objects you have created appears in the second pane of the Project 
Management toolbar (on the right, second from the top in the Project Management Toolbar). 
 
To adjust the visualization, zoom with the mouse wheel and pan by holding the wheel down 
and moving the mouse. To show the rendering on the full screen, either hover the mouse 
cursor over or click the bottom right image and hit the spacebar. The screen can be reset to the 
4-image view by hitting the spacebar again.   
 
After viewing the 3D rendered volume, hide the object by clicking on the eyeglasses  in the 
Project Management Toolbar.   
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Task B. Editing the Mask of the Aorta 
 
WHAT YOU ARE DOING: Further segmentation of the DICOM images to remove most of the branch 
vessels, followed by generation of an STL file (a different file format than DICOM that is recognized by 
3D printers). The STL file then undergoes a smoothing step smoothing called “wrapping”.  
WHY YOU ARE DOING IT: The product of each segmentation step we have performed thus far could 
be converted into a STL format and sent to the 3D printer; however, we desire to simplify the model and 
limit the amount of printing material needed by excluding the mesenteric branch vessels.  
HOW TO DO IT: The first part of this task uses a third segmentation tool, “Edit Mask in 3D”, that 
modifies the volume. This tool is not typically available in standard 3D visualization. We will use the 
Lasso tool from this tool kit to select a small portion of each proximal branch vessel near the ostium, 
which can then be “removed”. This breaks the voxel-to-voxel connection between the proximal and 
distal portions of individual branches of the (e.g., the superior mesenteric artery). Then, after Region 
Growing is reapplied, the distal branches are no longer rendered. The STL file will then be further 
refined using a smoothing tool called “Wrap” that eliminates rough areas and gaps in the model.   
 
Familiarize yourself with the following 3D interface shortcuts that will be used to edit your 
model in 3D. 
 

Shortcut Action 
Right mouse button Rotate: Move the mouse to rotate  
Shift + Right mouse button 
Center click on the mouse 

Pan: Move the mouse to pan 

Ctrl + Right mouse button Zoom: Move the mouse vertically to 
zoom 

ArrowUp / PageUp Rotate Up with discrete steps 
ArrowDown / Page Down Rotate Down with discrete steps 
Arrow Right / End Rotate Right with discrete steps 
Arrow Left / Home Rotate Left with discrete steps 

 
1. From the Segmentation Menu, choose Edit Mask in 3D to edit the mask in the 3D 
window. After choosing Edit Mask in 3D , the bottom right image will be the yellow aorta 
surrounded by a 3D transparent box, which indicates the fact that you are editing in 3D as 
opposed to 2D. Hit the space bar to enlarge the view. Click the right mouse button and move 
the mouse to rotate the image, and hold down the scroll wheel to pan the image so that the 
aorta is viewed laterally with the mesenteric arteries pointing to the right of the screen.  
 
2. Here is an image of the Edit Mask in 3D toolbar that appears at the top of the screen: 
 

 
 
We will use the Lasso tool to select small portions of the mesenteric arteries. Draw a loop 
around the portion you desire to remove. When the loop of the lasso has completely 
surrounded the vessel, the encircled area to be removed will appear as a highlighted area in 
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the model. Lasso small proximal portions of the celiac, SMA, IMA, and lumbar branches, as 
well as the mid-renal arteries. 
 
3. Hit the Remove button to disconnect the proximal from distal arteries. This will remove 
that portion of the artery, thereby disconnecting the distal mesenteric branches. Your lasso 
edits need not be perfect. Close the Edit mask in 3D toolbar, and then hit the spacebar to 
return from the enlarged view to the 4 window view. 

  

 
 

 
Hint: The changes that you apply in this operation will only affect the mask information. It will not affect any 3D 
models that you previously calculated. 
 
4. From the Segmentation Menu, choose Region Growing . Left mouse click within the 
lumen of the aorta (as you did earlier). This will remove the voxels that were disconnected in 
the previous step. There is now a new mask called “Cyan”. Rename this mask, “Aorta” by 
double-clicking on the name in the Masks tab of the Project Management Toolbar and typing 
the word Aorta. Note that at this stage, the bottom right window is empty—we are going to 
fill it by recalculating a new 3D model. 
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5. From the Segmentation Menu, choose Calculate 3D . You will see a window that 
allows you to select a Mask and a Quality setting to create a 3D model. Choose your Aorta 
mask and the Optimal setting. Press the Calculate button. 

 
Note: This calculates a 3D surface model of the region that was highlighted in the “Aorta” mask. This model is 
an STL file that describes the geometry as a set of connected triangles. STL is the file format needed to create a 
3D printed geometry. This differs from a volume rendered model (i.e., 3D visualization) in that it contains 
exportable surfaces. 
 
6. Change the color of your model by selecting your Aorta model and clicking on the 
Properties icon  in the 3D Objects tab of the Project Management Toolbar. Click on ‘Artery’ 
in the ‘Type’ drop-down menu within the 3D Properties Window. Click ‘OK’. 

 

 
 
 

7. From the Tools Menu, choose Wrap  to eliminate gaps and smooth rough areas on your 
model. The Smallest Detail in the new window should be set at 0.5 mm; this is on the order 
of the size of the CT voxel. This will eliminate rough areas representing image noise. The 
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Gap Closing Distance should be set at 2.0 mm. The gap closing distance refers to the largest 
separation between points for which anatomic variations will be smoothed. 
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Task C. Exporting the Aorta model to 3-matic (CAD software) 
 
WHAT YOU ARE DOING: Exporting the STL file from Mimics to 3-matic to perform final post-
processing steps. In 3-matic, the 3D rendering will undergo one level of smoothing. Then, the vessel 
wall will be rendered around vessel lumen. Finally, we will label the model before the final STL file is 
generated.  
WHY YOU ARE DOING IT: To refine our 3D model to eliminate surface imperfections in the 3D printed 
model. We will create a rendering of the aorta wall rather than the opacified intraluminal blood pool so 
the printed model can be used for benchtop tasks such as evaluation of device deployment or 
assessment of fluid flow dynamics†. The model will be labeled for identification purposes.   
HOW TO DO IT: We will export the final iteration of our STL file from Mimics into 3-matic. In 3-matic, we 
will perform an additional smoothing step. A rendering of the aorta wall will be generated using the 
“Hollow” tool. We then will visualize the lumen within the hollow model after cutting the vessel endings 
using the “Trim” tool.  “Quick label” will be used to apply a customized label. 
 
The screen shot below is displayed to familiarize you with the 3-matic interface. 

 
1. From the 3-matic Menu in Mimics, choose Design . Select the “Wrapped_Aorta” model 
and press, ‘OK’. This will open the model in the 3-matic software package. 
 

                                                   
† It is important to recognize that all of the initial processing steps are performed on the opacified lumen 
of the aorta, based on the fact that we initially segmented the high attenuation contrast material. Note 
that it can be very challenging to segment and 3D print very thin structures such as the normal arterial 
wall. Moreover, the intermediate attenuation of the actual wall (~40-60 HU) can limit the utility of tools 
such as thresholding that act on the entire data set. One solution is to generate and print a 
representation of the wall with a uniform thickness of 2 mm. This ‘artistic license’ can be used in 3D 
printing. However, this simplification has important consequences—anatomic detail in the aorta, 
including pathology in the wall, may be lost when the model is printed. Note that the representation of 
the lumen remains accurate, based on the completed segmentation steps. 
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2. From the Finish Menu, choose Local Smoothing   . Set the ‘Smoothing diameter’ 
within the Operations Tab to 10 (millimeters). To smooth out remaining rough areas, zoom in 
on the picture by using the mouse wheel. Then hold the left mouse button down over the 
region to be smoothed while making small circular movements.  
 
     
 
 
 
 
 
 
 
 

 
 
 

3. From the Design Menu, choose Hollow   to create the wall of the aorta. Copy the 
parameters in the screen shot below, and then click ‘Apply’. It will take some time for this 
operation to finish. 

 

 
 

 
4. To simultaneously visualize the wall and lumen renderings, right click the Wrapped Aorta 
model in the upper right window called “Scene Tree” and select Transparency > Medium. 
This will demonstrate the wall as a shadowed area around the bright aorta lumen. 
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5. From the Finish Menu, choose Trim.  Note that at present, the ends of the model are 
“closed” and the lumen cannot be seen. To open the ends of the model, free hand draw a box 
(see screen shot below) around the proximal aspect of the aorta and press Apply. To 
completely “open” the model, freehand draw additional boxes around the distal aspects of 
both distal common iliac arteries. Press ‘Apply’ after you generate each box to cut each 
respective portion. 
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The resulting model should now be cut open at the ends, enabling visualization of the lumen.‡ 
 
 

  

                                                   
‡ Prior to exporting the STL, it is possible to verify the accuracy of the completed 3D model 
against the original DICOM data.  Due to time constraints, this is covered in Appendix 2. 
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6. Rotate the model sidewise. We are now going to add a label. From the Finish Menu, 

choose Quick Label  . You can label your 3D model with your name and “RSNA 2014” 
in the “Text” box under Label parameters (screen shot below). Change the font height to 
3.0000. Click on the model where you would like to place the label (if you press ‘Ctrl’ while 
applying the label, it will be inset rather than raised off the surface).  

 

        
 
 
 
The model will now bear a label with the information you entered. 
 

 
 

7. From the Export Menu, choose Binary STL. Note that this is the step that generates the 
STL file that will be exported to the 3D printer. Define the output directory as the desktop. 
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Task D. 3D printing the STL file 
 
WHAT YOU ARE DOING: Using a new software platform called Objet Studio to place the aorta on the 
“build tray”, the platform on which the model will be built. After visualizing the aorta from different 
perspectives, we will assign the material and “send” the job. 
WHY YOU ARE DOING IT: In Mimics and 3-matic, we have generated the STL file. Objet Studio is a 
software package associated with the 3D printer used to organize print jobs, select the materials, and 
execute printing.   
HOW TO DO IT: The STL file will be imported into the new software package. Next, the file is rendered 
as it will be printed on the build tray. The orientation can then be adjusted, and the material selected. 
 
We have now switched software packages and will simulate the printing of the aorta model 
using Objet Studio. 
 
1. Open Objet Studio by double-clicking on the Objet Studio icon: 

 
A dialog box will open, asking you to select a printing server connection. We do not have a 
server at RSNA, so please use “Unknown”. This will allow us to work off-line. 

 
The main screen of Objet Studio will open as shown in the screen capture below: 
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2. To import the aorta STL file, click the upper left menu item “Insert”, and select your 
model from the dialog box that opens: 

 
Your model will be automatically imported onto the software representation of the build tray 
of the printer. The build tray is shown in blue below. The orientation of the aorta is optimized 
so that the support material needed for the 3D printing job can be minimized (It would be 
possible, but far less efficient, to print the aorta standing “upright” rather than “lying down”). 
 

 

3.  Model visualization. As shown in the prior screen capture, the default view is of the entire 
build tray of the 3D printer in a single isometric view. In the tab “Model Settings” you can 
zoom into the model in this view by clicking the icon “Zoom Tray”, and selecting “Zoom 
Selected Object”. The result will appear as follows: 
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In practice, with several objects on the build tray, it is important to be able to change the 
orientation of the model. This can be done by choosing “Isometric View”, and navigating the 
pull-down menu to “Northeast Isometric”, then repeating the zoom by clicking the icon 
“Zoom Tray” and selecting “Zoom Selected Object”.  This series of key stokes will move 
the model on the tray with the result as follows: 
 

 
For some jobs it will be advantageous to study the model in a 4-axis view. To do this, click 
the icon “Single View” and select “4 View”.  To make your screen appear as below, click on 
each individual window, make sure that the abdominal aorta is selected by single-clicking on 
it, and select “Zoom Object” for a close-up view. 
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To complete further operations on this model, return to the single window view by clicking 
the “4 View” icon and then select “Single View”. Then click “Isometric View”, and select 
the “Northeast Orientation” in the pull-down menu.  Zoom into the selected model by 
clicking “Zoom Object”. You should have on your screen the following: 
 

 

4. Next, we will assign the material to be used to build the model and start the 3D printing job. 
Click on the left-most tab labeled “Tray Settings”. We will change the material settings to 
Tango+, an elastomeric material.  To do this, select the first material pull-down menu on the 
right of the “Tray Setting” menu that says “VeroBlack”, and select “Tango+”. Your model 
will change color, reflecting the printing in Tango+. There will be a confirmatory dialog box 
pop-up. 
 
 

 

In a production environment where the printer is connected to a print server, you would then 
proceed to the “Job Manager” menu tab to connect to the printer, send the job, and ensure 
that the material store in the printer is sufficient to complete the job.  
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APPENDIX 1. Importing DICOM images into Mimics. 
 

1. Open Mimics 17.0 from the Start Menu or desktop icon. 
 

2. Select the New Project Wizard from the File Menu. 
 
3. Browse to the location of your DICOM images.  Click Next. 
 
4. The following window will show the studies contained within the folder.  This gives a preview of 

the images and the DICOM tags.  Choose Convert.  
 
5. Indicate the orientation in the orientation window. After clicking ‘OK’ the Mimics project is 

opened and work can be started. 
 

 
APPENDIX 2. Verifying the Accuracy of the Model 
 
Before exporting the model for 3D printing or using it for any further design, you may want to check that the 
model is an accurate representation of the patient’s anatomy by bringing it back into Mimics and comparing it to 
the original images. 

 
1. In 3-matic, click on the model name in the Scene Tree. Copy it by using CTRL+C on your 

keyboard. 
 

2. Go back to Mimics project and paste the model using CTRL+V. You will see it appear in the STLs 
tab of the Project Management Toolbar. 

 
3. Make the contours of the Aorta model visible in the image views by clicking on the ‘Contours 

Visible’  sunglasses icon in the STLs tab. 
 

 
 

4. Scroll through the images to ensure that the model accurately follows the geometry of the rendered 
anatomic structure. 
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